Instruction Guide
for using the
Compliance Plan Template
Contents

Saving the template files on your computer................................................................. 1

Preparing Data for complianceplan.csv ........................................................................ 3
  Prepare data via the Run Patch option ........................................................................ 3
  Prepare data via the individual workbooks option ....................................................... 10
    Using the Pavement Asset Management Plan workbook ......................................... 10
    Using the Bridge Asset Management Plan workbook .............................................. 16
  Prepare data via manual input option......................................................................... 29

Auto-generating CompliancePlan.csv from prepared data ............................................ 30

Inserting/Re-inserting chart/graph images from the Excel workbooks ................................ 33

Opening the Word template .......................................................................................... 35

Linking the Excel spreadsheet data to the Word template .............................................. 35

Inserting content into the compliance plan Word template ........................................... 38
  Inserting a logo .............................................................................................................. 38
  Inserting charts ............................................................................................................ 39
  Inserting images .......................................................................................................... 40

Creating map images from Roadsoft ............................................................................. 42
  Creating image for 1. Pavement Assets > Inventory of Assets (Figure 1) ..................... 42
  Creating image for 1. Pavement Assets > Planned Projects (Figure 6) ......................... 50
  Creating image for 2. Bridge Assets > Inventory of Assets (Figure 7) ......................... 56
  Creating image for 6. Risk of Failure Analysis (Figure 9) ............................................ 61
  Creating images from PDF files ................................................................................ 69

Completing the Word template ....................................................................................... 71

Generating annual cost projection data for bridge assets from budget template .......... 76

Reviewing the template for errors and finalizing ......................................................... 77

Updating the Table of Contents .................................................................................... 79

Inserting Appendixes .................................................................................................... 80

© 2019 Center for Technology & Training. All rights reserved.
Prepared on behalf of the Michigan Transportation Asset Management Council.
This document provides instruction for creating a personalized compliance plan for your specific agency by using the files CompliancePlan.docm and complianceplan_blank.csv distributed to you by the Center for Technology & Training in collaboration with the Transportation Asset Management Council and the Michigan Department of Transportation. Compliance plan data for your agency will need to come from the Pavement Asset Management Plan workbook or Bridge Asset Management Plan workbook or will need to be entered manually into the complianceplan_blank.csv Microsoft Excel spreadsheet. This Instruction Guide will detail how to merge data into the Word template and will provide guidance for entering data into the Excel sheet.

**Saving the template files on your computer**

The two template files for creating a compliance plan will be provided to you on a USB drive. **Do not rename these files at any time while working with them.** These files should be stored on your PC in a location that is easy to find and access. It is recommended that a new subfolder be created in your Documents or My Documents folder or on your desktop. This new (sub)folder should be given a unique name, such as “Compliance-Plan-2019”. Copies of the .docm and .csv files should be saved in that new (sub)folder. It is also recommended that any other content needed for your compliance plan—such as logos and images—be kept in this folder, as well (see figure below).
NOTE: You will have two initial files within your main compliance folder: CompliancePlan_v2019.docm and complianceplan_blank.csv. If you have used the 2019 pavement asset management plan or the revised 2019 bridge asset management plan tools, you will have two additional files that should be stored in this folder- bcomplianceplan_agencyabbr.csv and pcomplianceplan_agencyabbr.csv (see figure below).
Preparing Data for complianceplan.csv

Data for the complianceplan.csv file can be compiled in one of three ways. If you downloaded your asset management tools at different times preceding and following August 25, 2020, use the **Prepare data via the Run Patch option**; you will want to use the 09/08/2020 download of the compliance plan tools for this. This procedure works for all versions of the asset management tools. If you downloaded all of your asset management tools after August 25, 2020, you can choose to use the **Prepare data via the individual workbooks option**. Finally, you can use the **Prepare data via manual input option**.

**Prepare data via the Run Patch option**

**NOTE:** This is the preferred method for preparing your data. You will want to download the 09/08/2020 version to use this option. You must use this option if you downloaded your pavement and bridge asset management tools at various times preceding and following August 25, 2020. The Compliance Plan tools download should contain both CompliancePlan_v2019.docm and patchCompliancePlan_v2019.xlsm file.

To run the patch, open CompliancePlan_v2019.docm and then:

1. Select the **Run Patch** button in the *Quick Access* toolbar (see figure below).

   ![Run Patch button](image)

   - A dialogue box will open confirming that you want to run the patch (see figure below).

   ![Dialogue box](image)

   - Select **YES** (see figure above).
This will open the *patchCompliancePlan_v2019.xlsm* Excel workbook. You should notice Excel flashing orange in your task bar (see figure below).

3. Select the flashing-orange Excel icon (see figure above).

A dialogue box will appear indicating that you will need to locate your pavement asset management plan *DataMacro_pavementAMP_v2019.xlsm* file (see figure below).

4. Select **OK** to begin locating the file (see figure above).

The *Please choose your DataMacro_pavementAMP_v2019.xlsm file to open* window will appear (see figure below).

5. Locate your *DataMacro_pavementAMP_v2019.xlsm* file and select **Open** (see figure above).
The DataMacro_pavementAMP_v2019.xlsm dialogue box The following files are missing... may or may not appear (see figure below). If it does not appear, you have completed your pavement asset management plan tool already and the compliance plan patch will advance to the next step. If it does appear, you have not completed your pavement asset management plan tool and will need to exit the compliance plan tool process, completed the pavement asset management plan tool process, and return to the compliance plan tool process.

If this is the first time running the patch, a dialogue box will appear indicating the creation of a charts folder (see figure below).

6. Select OK to acknowledge the creation of a charts folder. A dialogue box will appear indicating the creation of a pavement subfolder (see figure, left, below).
NOTE: If this is the second (or subsequent) time running the patch, a pre-existing pavement images subfolder will be deleted and a new one will be created with the most recent versions of your chart/graph images (see figure, right, below).

7. Select OK to acknowledge creation of a pavement subfolder.

⇒ A dialogue box will appear indicating that the pavement charts have been exported as images (see figure below).

8. Select OK to acknowledge that the pavement charts were exported as images (see figure above).

⇒ A dialogue box will appear indicating that you will need to locate your bridge asset management plan BridgeAMP-Data_v2019.xlsm file (see figure below).

9. Select OK to proceed to locating your BridgeAMP-Data_v2019.xlsm file.
10. Locate your BridgeAMP_pavementAMP_v2019.xlsm file and select Open (see figure above).

⇒ A dialogue box will appear indicating the creation of a bridge subfolder (see figure, left, below).

**NOTE:** If this is the second (or subsequent) time running the patch, a pre-existing bridge image subfolder will be deleted and a new one will be created with the most recent version of your progress tracking graph image (see figure, right, below).

11. Select OK to acknowledge creation of a bridge subfolder.

⇒ A dialogue box will appear indicating that the bridge chart has been exported as an image (see figure below).
12. Select **OK** to acknowledge that the bridge chart was exported as an image and to continue using the standard compliance plan steps (see figure above).

⇒ A dialogue box will appear asking which method of forecasting you are using.

13. Select **Yes** if you are using NCPP (see figure below).

    OR: Select **No** if you are using Roadsoft (see figure below).

    OR: Select **Cancel** to cancel (see figure below).

⇒ If you choose **Yes** or **No**, a dialogue box will confirm that you are done with running the patch (see figure, right, below). If you choose **Cancel**, a dialogue box will prompt you to delete manually the irrelevant NCPP or Roadsoft paragraphs (see figure, left, below).
14. Select **OK**.

These steps have produced the pcomplianceplan_rev.csv and bcomplianceplan_rev.csv files as well as a charts folder containing pavement and bridge subfolders with images. Proceed to **Auto-generate CompliancePlan.csv from prepared data** on page 30.
Prepare data via the individual workbooks option

**NOTE:** You may choose to use this option if you downloaded your pavement and bridge asset management tools following August 25, 2020. The 2019 pavement asset management plan workbook (DataMacro_pavementAMP_v2019.xlsm) and the revised 2019 bridge asset management plan workbook (i.e., BridgeAMP-Data_v2019.xlsm) can be used for inserting data (through export of asset-specific .csv files that merge into the complianceplan_blank.csv file to create complianceplan.csv), formatting the compliance plan Word template, and exporting graphs as images.

**Using the Pavement Asset Management Plan workbook**

**NOTE:** This instruction assumes you have completed your 2019 pavement asset management plan workbook (i.e., DataMacro_pavementAMP_v2019.xlsm).

**NOTE:** Before continuing with this procedure, ensure that all instances of Microsoft Word are closed. During this procedure, Microsoft Excel will automatically close the entire Microsoft Word program. When using the pavement asset management plan workbook (i.e., DataMacro_pavementAMP_v2019.xlsm) sequentially from the Instructions tab through to the Charts tab, the workbook will give you the option to save and close any open Word documents before closing the program entirely. If you are building your compliance plan by working sequentially through the pavement asset management plan workbook, the workbook will give you the option to save and close any open Word documents; if you are using a pavement asset management plan workbook that has already by populated with your data and bypassing steps to advance to the steps for building your compliance plan, this procedure bypasses the Excel option to save and close any open Microsoft Word documents. **Be sure all instances of Microsoft Word are closed before continuing with this procedure.**

1. Open the DataMacro_pavementAMP_v2019.xlsm file in Microsoft Excel.
2. Right-click on the Instruction tab at the bottom of the worksheet (see figure below).

- A flyout menu will open.

3. Select Unhide from the flyout menu (see figure above).

- The Unhide window will open.

4. Select Charts from the list in the Unhide window.

5. Select OK.

- The Charts worksheet should open, and you should automatically proceed to the Charts worksheet.

6. Select Step 3a: Locate Compliance plan (CP) template (see figure below).
7. Select **OK** (see figure above).

8. Navigate in the **Please select your compliance plan template** window to your compliance plan Word template file (e.g., CompliancePlan_v2019.docm), and select the file (see figure above).

9. Select **Open**.

The **Compliance plan has been located** dialogue box will open (see figure below).
10. Select **OK** (see figure above).

   ⇒ The buttons for Step 3b and Step 3c will become active (see figure below).

11. Select **Step3b: Export CP charts & format template** (see figure above).

   **NOTE:** Microsoft Excel will automatically close the entire Microsoft Word program during this step.

   ⇒ A dialogue box will appear indicating the creating of a pavement subfolder (see figure, left, below).

   **NOTE:** If this is the second (or subsequent) time running this step, a pre-existing pavement subfolder will be deleted and a new one will be created with the most recent versions of your chart/graph images (see figure, right, below).

   ⇒ A dialogue box will open informing you that your charts have been exported into the compliance plan Word template (see figure below). Your compliance plan Word template will be open at this
point. The dialogue box will indicate that the process will continue by formatting the document based on your chosen modelling/forecasting method.

12. Select **OK** (see figure above).

⇒ The workbook will continue to format your Word template according to your chosen modelling/forecasting method. Your compliance plan Word template will be saved and will close during this process. A dialogue box will open informing you that your compliance plan Word template has been formatted and reminding you to export a .csv file of your pavement asset management data (see figure below).
13. Select **Step 3c: Build CSV for CP** (see figure below).

![Diagram showing Step 3c: Build CSV for CP](image)

- A dialogue box will open prompting you to agree to the default .csv file name or to create your own file name (see figure below).

![Dialogue box for CSV file name](image)

14. Select **Yes** to accept the default file name (see figure above).

   **OR:** Select **No** to create your own file name (see figure above).

   **OR:** Select **Cancel** to exit this process without exporting a .csv file (see figure above).

- If Yes or No was selected, the **Your compliance plan is ready to use** dialogue box will appear. A .csv file populated with your pavement asset management plan workbook (i.e., DataMacro_pavementAMP_v2019.xlsm) data will be output in a format useable by the compliance plan template files; this output will be saved in the same folder as your compliance plan materials (identified when selecting the Step 3a button). The file will be pcomplianceplan_AGENCYABBREV.csv. These steps will also generate a charts folder containing a pavement subfolder with images. Proceed to Using the Bridge Asset Management Plan Workbook (below) or, if you have already followed the compliance plan process in your bridge asset management plan workbook, proceed to **Auto-generate CompliancePlan.csv from prepared data** on page 30.
Using the Bridge Asset Management Plan workbook

**NOTE:** This instruction assumes you have completed your revised 2019 bridge asset management plan workbook (i.e., BridgeAMP-Data_v2019.xlsx).

**NOTE:** Before continuing with this procedure, ensure that all instances of Microsoft Word are closed. During this procedure, Microsoft Excel will automatically close the entire Microsoft Word program. When using the bridge asset management plan workbook (i.e., BridgeAMP-Data_v2019.xlsx) sequentially from the Instructions tab through all of the numbered tabs to the TOC tab, the workbook will give you the option to save and close any open Word documents before closing the program entirely. If you are building your compliance plan by working sequentially through the bridge asset management plan workbook, the workbook will give you the option to save and close any open Word documents; if you are using a bridge asset management plan workbook that has already been populated with your data and bypassing steps to advance to the steps for building your compliance plan, this procedure bypasses the Excel option to save and close any open Microsoft Word documents. **Be sure all instances of Microsoft Word are closed before continuing with this procedure.**

1. Open the BridgeAMP-Data_v2019.xlsx file in Microsoft Excel.

2. Right-click on the **Instruction** tab at the bottom of the worksheet (see figure below).

   ![ Instructions tab in Excel](image)

   ⇨ A flyout menu will open.

3. Select **Unhide** from the flyout menu (see figure above).

   ⇨ The Unhide window will open.
4. Select TOC from the list in the Unhide window.

5. Select OK.

⇒ The TOC worksheet should open, and you should automatically proceed to the TOC worksheet (see figure below).

6. Select Build a Compliance Plan (see figure above).
A dialogue box will open prompting you to find and select your compliance plan Word template file (i.e., CompliancePlan_v2019.docm) from a file dialogue box that will open (see figure below).

7. Select **OK** (see figure above).

The Please select your COMPLIANCE PLAN CSV template file window will open (see figure below).

8. Navigate in the Please select your COMPLIANCE PLAN CSV template file window to your compliance plan Word template file (i.e., CompliancePlan_v2019.docm), and select the file (see figure above).
9. Select **Open**.

- The buttons for CP Step 1, CP Step 2, Step 3, and DONE will become active. A dialogue box will open prompting you to proceed to CP Step 1 (see figure below).

10. Select **Yes** to proceed to CP Step 1 (see figure above).

OR: Select **No** to proceed to DONE (proceed to step 19, below) (see figure above).

11. If Yes was selected, select **CP Step 1: Export PT Graph** (see figure below).
12. Select **Yes** to insert your progress tracking graph into your compliance plan template (see figure above).

OR: Select **No** to skip inserting your progress tracking graph into your compliance plan template (see figure above).

OR: Select **Cancel** to exit this process without exporting the progress tracking graph to the template (see figure above).

**NOTE:** Microsoft Excel will automatically close the entire Microsoft Word program at this point.

⇒ If Yes was selected, your graph will be exported to the compliance plan Word template file (e.g., CompliancePlan_v2019.docm) that you chose in steps 8 and 9, above. Your compliance plan Word template will open, be saved, and close at this point; and, the entire Microsoft Word program will close. A dialogue box will also open prompting you to proceed to CP Step 2 (see second figure below).

⇒ If No was selected, a subsequent dialogue box will open to confirm that you wish to bypass inserting your progress tracking graph into your compliance plan Word template (see first figure below). Select **Yes** if you are sure you want to skip inserting the progress tracking graph into your compliance plan Word template. OR, select **No** if you want to insert the progress tracking graph into your compliance plan Word template (see first figure below). A dialogue box will then open prompting you to proceed to CP Step 2 (see second figure below).
13. In the dialogue box prompting you to proceed to CP Step 2, select **Yes** to proceed to CP Step 2 (see figure with *If Yes was selected*, above).

   OR: Select **No** to proceed to DONE (proceed to step 19, below) (see figure with *If Yes was selected*, above).
14. Select **CP Step 2: Export CSV for CP** (see figure below).

**NOTE:** If you have already performed this procedure and created a .csv file for your compliance plan Word template (e.g., CompliancePlan_v2019.docm), a warning box will ask you if you wish to overwrite this file (see figure below). Select **Yes** to overwrite the file and proceed to the next step. OR, select **No** to locate and delete the previously-created file yourself; the select **CP Step2: Export CSV for CP** again to continue with the process.
A .csv file named bcomplianceplan_agencyabbr.csv (where “agencyabbr” is the abbreviated name you assigned your agency in the questionnaire worksheet) will be created in the same folder as the compliance plan Word template (e.g., CompliancePlan_v2019.docm) identified in steps 8 and 9, above. A dialogue box will also open prompting you to proceed to CP Step 3 (see figure below).

15. In the dialogue box prompting you to proceed to CP Step 3, select **Yes** to proceed to CP Step 3 (see figure above).

OR: Select **No** to proceed to DONE (proceed to step 19, below) (see figure above).
16. Select **Step3: Open Appendixes to Print** (see figure below).

![Worksheet Table of Contents](image)

The three *Appendix* worksheets will open (see figure below).

17. Print each appendix worksheet as a PDF to attach to the compliance plan as appendixes.

**NOTE**: The *Appendix* worksheets have formulas associated with each cell. These formulas parse the data from other worksheets into an appendix format. To help ensure that the formulas are not inadvertently altered, the appendix worksheets are protected sheets. The protection is set to allow you to format the cells with column and row lines. If, for any reason, you need to unprotect the sheet, open the *Review* tab and select *Unprotect Sheet* from the *Changes* group; this will leave the worksheet’s formulas vulnerable to inadvertent changes that will render the Excel file useless for inserting data into the Word template.

a. Verify that the information transferred correctly into the appendix worksheets by visually assessing the worksheets.
**NOTE:** The three appendixes are indicated by Appendix A-1, Appendix A-2, and Appendix A-3 tabs. Selecting the tab makes that worksheet active (see figure above).

b. Select the tab for the first appendix that you wish to export for your bridge asset management plan (see figure above).

c. Select the A1 cell (this is a merged cell, so it will span several columns) in the selected appendix and, while holding down the left mouse button, drag your cursor to and inclusive of the last row of data and to and inclusive of the last column of data. Release the left mouse button (see figure below).

OR: Select the A1 cell (this is a merged cell, so it will span several columns). While holding down the **Shift** key on your keyboard, use the **↓** and **→** arrow keys to select all of the cells to and inclusive of the last row and last column of data. Release the **Shift** key and the arrow keys (see figure below).

d. Select **File** from the main menu (see figure below).

e. Select **Export** from the **File** options (see figure below).

⇒ The *Publish as PDF or XPS* window will open (see figure below).
f. Select the desired file location for saving the Appendix export in the Publish as PDF or XPS window (see figure below); and, enter the desired file name in the File Name field. **NOTE:** Leave the Save as type option set to PDF (*pdf) (see figure below).

**NOTE:** It is recommended to save the Appendix exports in the same location as the compliance plan files.

![PDF or XPS window](image1.png)

![Options window](image2.png)

**g.** Select the **Options…** button in the Publish as PDF or XPS window (see figure above).

![Options window](image2.png)

**h.** Select **Selection** in the Publish what group; leave the other options set to their defaults (see figure above).
i. Select the **OK** button in the *Options* window (see figure above).

j. Select the **Publish** button in the *Publish as PDF or XPS* window.

A .pdf file of your selected appendix will be generated and will be saved in the location that you specified.

k. Repeat steps b through j for the remaining two appendices.

**NOTE:** This procedure will generate three PDF files, one for each appendix. A similar export process can be done in Word to convert the Word portion of the bridge asset management plan into a PDF, as well; a PDF of the Word portion of the bridge asset management plan can serve as appendix B for the compliance plan. The full version of Adobe Acrobat or a free, open-source app can give you the capability to merge the four PDFs into a single PDF file.

18. Select **Hide** in the *Appendixes* row to hide the appendix worksheets (see figure below).

19. Select **DONE** (see figure below).
The Build a Compliance Plan buttons will deactivate. These steps will generate a file, `bcomplianceplan_AGENCYABBREV.csv`, that will be saved in the same folder as your CompliancePlan_v2019.docm file. These steps will also generate a charts folder containing a bridge subfolder with the progress tracking graph image. Proceed to *Using the Pavement Asset Management Plan Workbook* (above) or, if you have already followed the compliance plan process in your pavement asset management plan workbook, proceed to *Auto-generate CompliancePlan.csv from prepared data* on page 30.
Prepare data via manual input option

NOTE: If you have used the 2019 pavement asset management plan workbook (i.e., DataMacro_pavementAMP_v2019.xlsm) and/or the revised 2019 bridge asset management plan workbook (i.e., BridgeAMP-Data_v2019.xlsm), you can auto-generate data for the complianceplan.csv file. Please refer to the instructions in the Auto-generate data for CSV section below.

1. Open the complianceplan_blank.csv file in Microsoft Excel.

2. Input data in row 2 based on the prompts in row 1 and your agency’s situation (see figure below).

   NOTE: Do not change column headings in row 1. These headings correspond with fields set in the Microsoft Word template.

3. Save the .csv as complianceplan.csv.

   These steps will generate a file, complianceplan.csv, that has the necessary data in the correct locations. Proceed to Opening the Word template on page 35.
Auto-generating CompliancePlan.csv from prepared data

**NOTE:** If you have not used the 2019 pavement asset management plan workbook (DataMacro_pavementAMP_v2019.xlsm) or the revised 2019 bridge asset management plan workbook (i.e., BridgeAMP-Data_v2019.xlsm), you must manually update the complianceplan.csv file. Please refer to the instructions in the *Manually Input data into CSV* section above.

**NOTE:** This instruction uses two files named “pcomplianceplan_agencyabbr.csv” and “bcomplianceplan_agencyabbr.csv” for demonstration purposes. Your output files from the 2019 pavement asset management plan workbook (DataMacro_pavementAMP_v2019.xlsm) and the revised 2019 bridge asset management plan workbook (i.e., BridgeAMP-Data_v2019.xlsm) will be named with the agency name abbreviation that you entered into the questionnaire worksheet instead of “agencyabbr”.

1. Open the CompliancePlan_v2019.docm file in Microsoft Word.
2. Select the **Build CP CSV** button in the *Quick Access* toolbar (see figure below).

   ![Quick Access toolbar](image)

   An input box requesting the file path for your compliance plan files will open.

3. Enter the folder path (excluding any final backslash ()) where your compliance plan files (CompliancePlan_v2019.docm and complianceplan_blank.csv and, optionally, bcomplianceplan_agencyabbr.csv and pcomplianceplan_agencyabbr.csv) are stored (see figure below).

   ![Microsoft Word](image)

4. Select **OK**.
5. Select your complianceplan_blank.csv file from within the window (see figure below).

6. Select OK.

7. Select your pcomplianceplan_agencyabbr.csv or your pcomplianceplan_rev.csv file from within the window (see figure below).

8. Select OK.

9. Select your bcomplianceplan_agencyabbr.csv or your bcomplianceplan_rev.csv file from within the window (see figure below).
10. Select **OK**.

- Dialogue box prompts will open for any data field that has divergent data entries between the complianceplan_blank.csv, the pcomplianceplan_agencyabbr.csv, and the bcomplianceplan_agencyabbr.csv files (see figure below).

**NOTE:** Since this procedure merges data from your 2019 pavement asset management plan workbook (DataMacro_pavementAMP_v2019.xlsm) and your revised 2019 bridge asset management plan workbook (i.e., BridgeAMP-Data_v2019.xlsm) outputs, any data fields that appear in both workbooks will need to be merged into one field at this point (see figure below).

11. Select **Yes** to retain or **No** to replace the identified information.

- The complianceplan_blank.csv file will now be saved as complianceplan.csv. The complianceplan.csv file will contain all output data from your 2019 pavement asset management plan workbook (i.e., data that was output as pcomplianceplan_agencyabbr.csv) and your revised 2019 bridge asset management plan workbook (i.e., data that was output as bcomplianceplan_agencyabbr.csv) (see figure below).
Inserting/Re-inserting chart/graph images from the Excel workbooks

If you only want to insert or re-insert the chart/graph images within your Compliance Plan, you will use the **Insert Images** button. The following will show you how to use the **Insert Images** button in the *Quick Access* toolbar.

1. Select the **Insert Images** button in the *Quick Access* toolbar (see figure below).

![Quick Access toolbar with Insert Images button highlighted](image)

**NOTE:** If this is the first time using the Insert Images process, proceed to step 4. If this is the second (or subsequent) time using the Insert Images process, a *You have already replaced the bookmarks with chart/graph images* dialogue box will appear (see figure below); proceed to step 2.

![You have already replaced the bookmarks with chart/graph images](image)

2. Select **OK** in the *You have already replaced the bookmarks with chart/graph images* dialogue box (see figure above)

⇒ An *I have already deleted images* dialogue box will appear (see figure below).
3. Select **YES** if already-placed images have been deleted (see figure above). Select **NO** if already-placed images have not been deleted (see figure above).

(OP) If you selected **YES**, your chart/graph images will automatically be inserted. A *Chart/graph images have been placed* dialogue box will appear (see figure below).

(OP) If you selected **NO**, you will exit the process. Delete figures 2, 3, 4, 5, and 8, and repeat the process starting at step 1.

4. Select **OK** (see figure above).

(OP) Your document is ready to use. Proceed to *Linking the Excel spreadsheet data to the Word template*, *Inserting content into the compliance plan Word template*, *Creating map images in Roadsoft*, or *Completing the Word template*. 
Opening the Word template

Opening the compliance plan Word template (i.e., CompliancePlan_v2019.docm) will immediately cause Microsoft Word to request the link between the Word template and the Excel spreadsheet data to be established. It is safest to re-link the file using the Mailing tools in Word (procedure detailed below) rather than initiating the link in response to the warning dialogue box that appears upon opening the Word template.


⇒ A Microsoft Word warning box will open (see figure below).

2. Select No.

⇒ The Word template will open. Proceed to the instructions for Linking the Excel spreadsheet data to the Word template.

Linking the Excel spreadsheet data to the Word template

This step is required if you chose the Prepare data via manual input option; the other preparation options automatically linked the Excel spreadsheet to the Word template during the Build CP CSV procedure. To link the Excel spreadsheet data with the Word template and auto-fill corresponding text fields:

1. Open the CompliancePlan_v2019.docm Word template in Microsoft Word.

2. Select the Mailings tab.

3. In the Mailings tab, select the Select Recipients from the Start Mail Merge group; then, select Use an Existing List from the dropdown menu.
4. Navigate to the save location for your compliance plan files—specifically your complianceplan.csv file—using the Select Data Source window; then, select the complianceplan.csv file and select Open (see figure below).

⊿ The File Conversion window will appear (see figure below).

5. Select Window (Default) in the File Conversion – complianceplan.csv window, and select OK (see figure above).
The complianceplan.csv file is now linked to the Word template and the data has been imported into the document.

6. In the Mailings tab (after opening up the complianceplan.csv), select **Preview Results** in the **Preview Results** group to preview the document with this auto-filled data (see figure below).

Scroll through the document: Text fields previously enclosed with double-right and double-left carets (e.g.: «Agency_NameAbbreviation») should now be replaced with the appropriate data from row 2 of the complianceplan.csv Excel spreadsheet (see figure below).
Inserting content into the compliance plan Word template

Inserting a logo
There is one instance in the compliance plan where you will need to insert an image—the title page should incorporate your agency’s logo. A Picture placeholder indicates where the logo should be inserted.

To insert a logo into the Picture placeholder:

1. Select the Picture placeholder (shown below) where you plan to insert a logo (not a chart).

2. Select the icon in the center of the placeholder.

\[ \Rightarrow \] The Insert Pictures dialogue box will open (shown below).

3. Select Browse \( > \) in the From a file option row in the Insert Pictures dialogue box (see figure below).
The *Insert Picture* window will open (see figure below).

4. Navigate to your desired image using the *Insert Picture* window; select the image and then select **Insert** (see figure below).

![Insert Picture Window](image)

⇒ The *Picture* placeholder will be replaced with the selected logo or graphic.

**Inserting charts**
You may also choose to add Excel charts or graphs to your compliance plan Word template (i.e., CompliancePlan_v2019.docm). To insert Microsoft Excel charts/graphs into the Word document:

1. In the Excel workbook, select a chart/graph (see figure below).

![Excel Chart](image)

2. In the Excel workbook’s *Home* tab, select **Copy** from the *Clipboard* group to copy the chart/graph to the Windows clipboard.
   OR: Right-click on the chart/graph; select **Copy** from the dropdown menu.
   OR: Use the **Ctrl + C** keyboard shortcut.
3. In your compliance plan Word template (i.e., complianceplan_v2019.docm), place cursor at the position in the document where the chart or graph should be inserted.

**NOTE:** If your compliance plan Word template was not open before you started this procedure, you may open it now.

4. In Word’s *Home* tab, select **Paste** from the *Clipboard* group to paste the chart/graph that was copied to the Windows clipboard.

**OR:** Right-click where your cursor is positioned, and select **Paste** from the dropdown menu.

**OR:** Use the **Ctrl+V** keyboard shortcut.

### Inserting images
Maps and other images will help communicate your inventory of assets and your asset management goals.

**NOTE:** The procedure for creating maps in Roadsoft, exporting them as PDFs, and saving them as image files is detailed below.

To insert an image into the Word template:

1. Place cursor where you desire to insert an image.

2. Select **Pictures** in the *Insert* ribbon *Illustrations* group.

⇒ The *Insert Picture* window will open (see figure below).

3. Navigate to your desired image using the *Insert Picture* window; select the image and then select **Insert** (see figure below).
The picture will insert into the Word template.

4. Adjust by selecting the image and using **Wrap Text** option in the **Picture Tools > Format** ribbon (see figure below).
Creating map images from Roadsoft

The compliance plan Word template has four map images: figure 1 – inventory of pavement assets, figure 6 – pavement assets’ planned projects, figure 7 – inventory of bridge assets, and figure 9 – critical links in the road and bridge network. The following procedures detail the creation of each of these maps in Roadsoft and exporting them PDF files; an additional procedure explains the process of saving a PDF file as an image. The preceding section (above)—Inserting content into the compliance plan Word Template—details the procedure for inserting images into a Word document.

Creating image for 1. Pavement Assets > Inventory of Assets (Figure 1)

1. Display roads according to rating.

   a. Select **Show Legend Window** ( ) in the **Map tool options** bar.

      ⇨ The **Road Legend** window will open (see figure below).

   b. Select **Open Legend Builder** ( ) in the **Road Legend** window (see figure below).

      ⇨ The **Legend Builder** window will open (see figure below).
c. Choose the **Good/Fair/Poor** field from the *Legend Field* dropdown list (see figure above).

d. Move the good, fair, and poor rated road values down to the *Query* box of the *Legend Builder* window.

i. Highlight good, fair and poor unique values by selecting the first value (e.g., Good), holding down the *Alt* key on your keyboard, and selecting the subsequent unique values (e.g., Fair and Poor).

ii. Select **Add Selected Unique Value(s)**.

e. Select one condition *Query* value in the *Items* list.

f. Adjust color and font size of the selected value using *Feature* and *Outline* in the *Item Properties* box (see figure below).

g. Select **Apply Property to All Items** to apply adjusted color and font size to all *Query* items (see figure below).

h. Select **Yes** in the *Apply Selected Property* dialogue box (see figure above).

i. Select **Apply** in the bottom right of the *Legend Builder* window once the legend settings are correct.
2. Add an unpaved road filter.
   a. Select Filter ( Filter ) in the Map tool options bar.
   b. Select Apply Saved Filter as Selection… from the Filter dropdown list.
   c. From the list of filters, apply both the city and county unpaved roads filters (see figure below).
   d. Select OK.
e. Select **File** from the main menu, and select **Export/Upload >**.

f. Select **Export Layer to File** from the **Export/Upload >** flyout menu (see figure below).

- The **Export Road to Shapefile** window will open (see figure below).

- Select an **Export Path** (e.g., folder where you are storing your materials for your compliance plan) and enter a **File Name** (e.g. unpavedroadlayer) (see figure above).

h. Import the shape file as a layer.
i. Right-click on Road from the Map Layers window (see figure below).

![Map Layers window](image1)

ii. Select Add Layer from the flyout menu (see figure above).

⇒ The Add Map Layer window will open (see figure below).

![Add Map Layer window](image2)

iii. Select the External Layer tab in the Add Map Layer window (see figure above).

iv. Browse for the exported shape file using the Path browse button (see figure above).

⇒ The Select external file to add to the map window will open (see figure below).

![Select external file window](image3)

v. Navigate in the Select external file to add to the map window to the shape file exported in step 1, select the shape file, and select Open. (see figure below).
vi. Select **OK** in the **Add Map Layer** window.

⇒ The shape file will be added as a **Line Layer** in the **Map Layers** window (see figure below).

i. Right-click on the **Road** category once again (see figure above).

j. Select **Layer Properties** ( ).

⇒ The **Road Layer Properties** window will open (see figure below).

k. Select the **Legend** tab of the **Road Layer Properties** window (see figure below).

l. Adjust color and font size of the roads in the unpaved road layer (see figure below).

m. Select **Apply** (see figure below).

n. Ensure that both the **shape layer** (e.g., unpavedroadlayer) and the **Road** layer are selected in the **Line Layers** group of the **Map Layers** window; de-select the **Bridge** and **Intersection** layers of the **Point Layers** group.
3. Print the map as a PDF.

   a. When the map is ready, select **File** from the main menu (see figure below).

   b. Select **Print Current Map View** from the **File** menu (see figure below).

   ➜ The **Map Print Setup** window will open (see figure below).
c. Enter desired label information into the *Title* and *Subtitle* input boxes, and adjust the *Scalebar Units* and *legend* as desired (see figure above).

d. Select **Print Map** (see figure above).

⇒ The Windows *Print* window will open (see figure below).

e. Select **Microsoft Print to PDF** from the *Print* window (see figure above).

f. Select **Print** (see figure above).

⇒ The *Save Print Output As* window will open.

g. Navigate in the *Save Print Output As* window to the desired folder containing compliance plan materials, enter a descriptive file name in the *File name* input box (e.g., *complianceplan_figure1*), and select **Save**.
Creating image for 1. Pavement Assets > Planned Projects (Figure 6)

1. View projects.

   a. Select **Show Legend Window** ( ) in the *Map tool options* bar.

      ⊳ The *Road Legend* window will open (see figure below).

   b. Select **Open Legend Builder** ( ) in the *Road Legend* window (see figure above).

      ⊳ The *Legend Builder* window will open (see figure above).

   c. Select **Scheduled Maintenance Year** from the *Legend Field* dropdown box in the *Legend Builder* window (see figure above).
Relevant unique values will populate the *Unique Values* box (see figure below).

![Image of Legend Builder window](image)

**d.** Select a span of years in the *Unique Values* box by clicking the first year, holding down the *Shift* key, and then clicking the last year in the range (see figure below).

**NOTE:** Since the compliance plan is looking forward at the project you plan to do on your network, the selected span of years should begin during or after the publication year of your compliance plan and include the subsequent years corresponding to the subsequent years covered in your compliance plan.

⇒ All the selected years should be highlighted in blue.

**e.** Select *Add Selected Unique Value(s)* in the *Items* box of the Legend Builder window (see figure above).

**NOTE:** The years should appear in the *Items* box (lower left).

**NOTE:** If any other values are listed in the *Items* box, these values should be deleted so that only the desired project years are listed (see figure below).

**f.** Select one year Query item in the *Items* list.
g. Adjust color and font size of the selected item using *Feature* and *Outline* in the *Item Properties* box (see figure below).

h. Select **Apply Property to All Items** to apply adjusted color and font size to all Query items (see figure below).

i. The **Apply Selected Property** dialogue box will open (see figure below).

![Apply Property to All Items](image1)

j. Select **Yes** in the **Apply Selected Property** dialogue box (see figure above).

k. Select **Apply** in the bottom right of the **Legend Builder** window once the legend settings are correct.

⇒ The **Road Legend** window will display the applied legends (see figure below).

![Road Legend](image2)
1. Ensure that the **Road** layer is selected in the *Line Layers* group of the *Map Layers* window; de-select the **Bridge** and **Intersection** layers of the *Point Layers* group (see figure above).

2. Create a new project.

   a. In the *Map* window, select **Road Segment** in the *Map tool options* bar (see figure below).

   ![Map window with Road Segment selected](image)

   b. Select the segment(s) of road on the map where the project will take place (see figure above).

   ⇒ Selected segment(s) will be highlighted.

   c. Select the **Projects** in the *Map tool options* bar (see figure above).

   d. Select **Add Project Using Selection…** in the *Projects* dropdown menu.

   ⇒ The *Add Project* window will open (see figure below).
e. Fill out Project Information fields (i.e., Location, Project Number/ID, Surface Subtype, Life Expectancy, Estimated Costs, Total Costs, Start Date, status, Completion/Open To Traffic Date, Reactionary Project, Warranty Project, Description, Source of Funds, Memo).

**NOTE:** As long as the Start Date field data falls within the selected span of years (see step 1.c), the road segments will be displayed with the same color as the other road projects within the same span of years.

f. Select Save.

3. Print the map as a PDF.

   a. When the map is ready, select **File** from the main menu (see figure below).
b. Select **Print Current Map View** from the **File** menu (see figure below).

![Print Current Map View](image)

> **The Map Print Setup** window will open (see figure below).

![Map Print Setup](image)

c. Enter desired label information into the **Title** and **Subtitle** input boxes, and adjust the **Scalebar Units** and **legend** as desired (see figure above).

d. Select **Print Map** (see figure above).

> **The Windows Print** window will open (see figure below).

![Windows Print](image)
e. Select Microsoft Print to PDF from the Print window (see figure above).

f. Select Print (see figure above).

⇒ The Save Print Output As window will open.

g. Navigate in the Save Print Output As window to the desired folder containing compliance plan materials, enter a descriptive file name in the File name input box (e.g., complianceplan_figure6), and select Save.

Creating image for 2. Bridge Assets > Inventory of Assets (Figure 7)

1. Display bridges according to rating.

   a. Ensure Road is selected in the Line Layers group of the Map Layers window but has no legends associated with it.

   NOTE: To view legends associated with the Road layer:

   i. Select Road in the Map Layers window.

   ii. Select Show Legend Window ( ) in the Map tool options bar.

   iii. Select any legends listed, and select Delete a saved legend ( ).

   b. Select Bridge in the Map Layers window.

⇒ A prompt will appear if bridge data needs to be imported.
NOTE: To re-import bridge data, right-click on the Bridge and select Re-Import Bridge Data from the dropdown menu (see figure below).

c. Right-click on Bridge in the Map Layers window.

d. Select Legend Builder… ( ) from the dropdown menu.

⇒ The Legend Builder window will open (see figure below).

e. Select Good/Fair/Poor Rating from the Legend Field dropdown list.

⇒ Relevant unique values will populate the Unique Values box.

f. Select the Good, Fair, and Poor values by clicking the value (e.g., Good), holding down the Ctrl key, and then clicking all subsequent desired values (e.g., Fair and Poor).
All the selected unique values should be highlighted in blue.

g. **Add Selected Unique Value(s)** in the *Unique Values* box of the *Legend Builder* window.

**NOTE:** The good, fair, and poor values should appear in the *Items* box (lower left).

**NOTE:** If any other values are listed in the *Items* box, these values should be deleted so that only the desired project years are listed (see figure below).

h. Select the first Query item in the *Items* list, i.e., **Good/Fair/Poor Rating = Good**.

i. Adjust color to green and font size of the selected item using *Feature* and *Outline* in the *Item Properties* box.

j. Repeat steps 1h and 1i for **Good/Fair/Poor Rating = Fair** adjusting color to yellow and **Good/Fair/Poor Rating = Poor** adjusting color to red.

k. Select **Apply**.

**⇒** The map will display all bridges in the county with the rating-specific legend applied (see figure below).

2. Add a filter to display bridges based on ownership.

   a. Select **Filter** in the *Map tool options* bar.

   b. Select **Filter Builder…** from the *Filter* dropdown menu.
The Bridge Filter Builder window will open (see figure below).

![Bridge Filter Builder Window](image)

- The Bridge Filter Builder window will open (see figure below).

  c. Search for “owner” in the search bar of the Bridge Filter Builder window (see figure above).

  d. Select **Owner** in the **Field** list (see figure above).

  - The available operator(s) and value(s) will display.

  e. Select the desired operator in the **Operator** box and the desired value(s) associated with the selected operator in the **Value** box (see figure above).

  f. Select **Add** (to the right of the Value box) (see figure above).

  g. Select **Apply as Filter** in the Bridge Filter Builder window.

  **NOTE:** You may be prompted to save this filter in order to apply it. In this case, the **Save Filter** window will open; enter a unique name in the **Name** input box, (optional) associate the filter with a group using the **Group** dropdown list, (optional) share/create a private the filter by selecting/de-selecting **Shared Filter** check box, and then select **Save As**. Alternatively, if you are updating an already-saved filter, you may have to re-save the filter; select **Save** in the window prompting you to update the saved filter.

  h. Exit the Bridge Filter Builder window using the x in the top right corner.

  i. Check to make sure only the bridges owned by the value(s) chosen are displayed on the map.

3. Print the map as a PDF.

  a. When the map is ready, select **File** from the main menu (see figure below).
b. Select **Print Current Map View** from the *File* menu (see figure below).

![Image of Print Current Map View menu](image1)

⇒ The *Map Print Setup* window will open (see figure below).

![Image of Map Print Setup window](image2)

c. Enter desired label information into the *Title* and *Subtitle* input boxes, and adjust the *Scalebar Units* and *legend* as desired (see figure above).

![Image of Map Print Setup window](image3)

d. Select **Print Map** (see figure above).

⇒ The Windows *Print* window will open (see figure below).

![Image of Windows Print window](image4)
e. Select **Microsoft Print to PDF** from the *Print* window (see figure above).

f. Select **Print** (see figure above).

⇒ The *Save Print Output As* window will open.

g. Navigate in the *Save Print Output As* window to the desired folder containing compliance plan materials, enter a descriptive file name in the *File name* input box (e.g., `complianceplan_figure7`), and select **Save**.

### Creating image for 6. Risk of Failure Analysis (Figure 9)

1. Select **Road** in the *Map Layers* window.

2. Select **Road Segment** in the *Map tool options* bar (see figure below).

3. In the *Map* window, select a segment or multiple segments of road (see figure below).

**NOTE:** Hold down the **Ctrl** on your keyboard when selecting with the mouse in order to make multiple selections, or hold down the **Alt** key on your keyboard when selecting with the mouse in order to de-select a segment.

4. Right-click on any of the selected segments (see figure above).
5. Select **Save Selection as Filter**… from the dropdown list (see figure below).

![Dropdown list](image)

⇒ The **Save Selection as Filter** window will open (see figure below).

![Save Selection as Filter window](image)

6. Enter a name in the *Name* input box for filter.

7. If a risk group already exists, select risk group from the *Group* dropdown list.

   OR: If a risk group does not exist, type in the name of a new risk group in the *Group* field.

8. Right-click on a selected high-risk segment in the *Map* window.

9. Select **View Module**… from the dropdown list.
The Road Module tab will open (see figure below).

10. Select the User-Defined tab located on the left side of the Road Module tab (see figure above).

The User-Defined window will display (see figure below).

11. Select the plus sign to the left of the first user-defined field, “User Def 4” (see figure above).

This will expand the field options for that user defined field.

12. Select the Change Label… option associated with the User Def 4 field options (see figure above).
13. Enter a name for the user-defined field in the input box: “Risk” (see figure above).

14. Select OK.

15. Select the Add/Edit Risk… option associated with the Risk field options

16. Select Add (see figure above).

17. Enter a new name in the Description input field and an abbreviation in the Abbreviation input field for the new high-risk section.

18. Select Save.

**NOTE:** Save these options for the “Risk” user-defined field before creating values for every other high-risk section.
19. Select the X in the top right corner of the View/Edit Lookup/Defaults window to close the window and return to the map when finished.

⇒ User-defined values will now be added to the Road Module.

**NOTE:** These newly-added user-defined values still need to be applied to the appropriate segments. The Multi-edit tool is used to accomplish this.

20. Select the Map tab.

21. Right-click on the map.

22. Select **Apply Saved Filter as Selection...** from the dropdown menu.

23. Use the Group dropdown to locate the Risk group.

24. Select OK.

25. Select **View Module** in the Map tool options bar.

26. Select **Multi-edit** in the Road Module tab (see figure below).

![Multi-edit Tool](image)

27. Select **All Segments** from the dropdown menu.
28. Select **ALL Selected Segments** from the *PR* dropdown list.

29. Select **User-Defined** from the *Inventory* section of the window (see figure below).
30. Select Risk in the User Defined Fields box, and use the dropdown list at the right side of the field to select the first segment.

31. Repeat this steps 29 and 30 for each of the segments.

32. Apply legends to high-risk segments.

c. Select **Show Legend Window** ( ) in the *Map tool options* bar.

   ⇒ The *Road Legend* window will open (see figure below).

d. Select **Open Legend Builder** ( ) in the *Road Legend* window (see figure above).

   ⇒ The *Legend Builder* window will open (see figure above).

e. Select **Risk** from the *Legend Field* dropdown box in the *Legend Builder* window (see figure above).

   ⇒ Relevant unique values will populate the *Unique Values* box.

f. Select the desired segments.

   ⇒ All the selected segments should be highlighted in blue.

g. Select **Add Selected Unique Value(s)** ( ) in the *Unique Values* box of the *Legend Builder* window.

h. Values will be added to the Query in the *Items* box.

i. Select the first Query item in the *Items* list.

j. Adjust the color and font size using *Feature* and *Outline* in the *Item Properties* box.

k. Select **Apply Property to All Items** to apply adjusted color and font size to all Query items.

   OR: Repeat steps 32g and 32h for each Query item to create a unique legend for each item.

l. Select **Apply** ( ).
33. Print the map as a PDF.

c. When the map is ready, select **File** from the main menu (see figure below).

d. Select **Print Current Map View** from the **File** menu (see figure below).

![Map Print Setup Window](image)

⇒ **The Map Print Setup** window will open (see figure below).

e. Enter desired label information into the **Title** and **Subtitle** input boxes, and adjust the **Scalebar Units** and **legend** as desired (see figure above).

f. Select **Print Map** (see figure above).
g. Select **Microsoft Print to PDF** from the *Print* window (see figure above).

h. Select **Print** (see figure above).

⇒ The *Save Print Output As* window will open.

i. Navigate in the *Save Print Output As* window to the desired folder containing compliance plan materials, enter a descriptive file name in the *File name* input box (e.g., *complianceplan_figure9*), and select **Save**.

---

**Creating images from PDF files**

To create images from the four PDF Roadsoft map files, you will need a PDF reader/writer software program that allows you to save the PDF as an image. An example of this software is Adobe Acrobat.

1. Open each PDF map in the PDF software program.

2. Select **File** from the main menu.

3. Select **Save As** from the *File* menu.

4. Change *Save as type* to an image format (e.g., JPG, PNG, GIF, TIF).

Note: It is important to ensure that the save location for the file is the same folder where you are saving all of your compliance plan materials.
Note: The file name should remain the same as the PDF file name, but the extension will change from “.pdf” to the file extension corresponding with your selected image format.

5. Select **Save**.

6. Follow the procedures (detailed above) for inserting images into your compliance plan Word template.
Completing the Word template

The compliance plan Word template is automatically linked to your newly-generated complianceplan.csv file, which will populate the template with content based on your agency’s specified circumstances. However, several places in the Word template still require your input and editing.

1. Address all orange-text field prompts or comments/“Your Content Here” prompts (see figure below).

**NOTE:** <#Orange text fields> are placeholders for user-entered data. Each of these placeholders can be identified by its field formatting, its orange color, and its unique tagging “<#”. Each of these placeholders has a different prompt depending on the type of information to be inputted. An example of an orange text field is:

<# YOUR CONTENT HERE: Insert percent in ## format>

To address these prompts:

a. Navigate to the orange-text field prompts or comments/“Your Content Here” prompts.

i. Place cursor on the cover page, then toggle to each prompt using the F11 key on your keyboard.

OR: Visually search the document for orange-text fields and/or “Your Content Here” prompts.
OR: Select **Find** from the *Home* ribbon *Editing* group, and enter “<#” in the *Search document* input box. (Note: This will also find the missed auto-fills; see step 4, below).

b. Fill in content/responses manually.

**NOTE:** Some orange text field prompts are associated with dropdown selections for content/responses. The chosen dropdown selection or the manually-entered content/response should flow with the context of the paragraph or section.

2. Address all teal-commented optional sections (see figure below).

![Figure showing teal-commented sections]

**NOTE:** Teal-commented optional sections signal entire sections that are optional and can be deleted based on your agency’s circumstances. These sections are placed in content controls. In many cases, you will have a choice between alternate teal-commented sections for the same entire section; you may delete one or all options for the entire section if it does not apply to your agency’s circumstances. Optional sections are accompanied by instructions in the teal-highlighted comment. An example of an optional section’s instructional comment is:

*Use and/or modify the following section by right-clicking the content control and then “Remove Control” to retain text. To delete, select the control handle (entire content control area will highlight) and use your Delete key to delete content.*
Scrolling over an optional section will show its content control and will shade the content control in grey (see figure above). At this point, you may address the teal-commented optional section in one of three ways:

a. OPTION 1: Use and/or modify optional sections content:

i. Right-click anywhere inside the content control.

⇒ A drop-down menu will appear.

ii. Select **Remove Content Control** (see figure below).

⇒ The content control is now removed and the text has merged with the body of the document. You may now edit this section as part of the body itself.

b. OPTION 2: Create new sub-sections:

i. Place cursor in optional section content control.

⇒ The content control frame and handle (upper left corner) will open.

ii. Select the content control handle (see figure below).

iii. Copy the content control:

   In the *Home* ribbon, select **Copy** from the *Clipboard* group.
OR: Use the **Ctrl+C** keyboard shortcut.

iv. Place cursor at the end and outside the content-controlled area.

v. Paste the copied content control:
   In the *Home* ribbon, select **Paste** from the *Clipboard* group.

OR: Use the **Ctrl+V** keyboard shortcut.

c. **OPTION 3:** Delete optional sections entirely.

i. Place cursor in optional section content control.

⇒ The content control frame and handle (upper left corner) will open.

ii. Select the content control handle (see figure above).

iii. Press the **Delete** key on your keyboard.

⇒ This removes the entire optional section.
3. Address comments.

**NOTE**: Comments appear along the right side of the Word document. If you do not see comments, ensure that the markup dropdown menu in the Review ribbon Tracking group says “All Markup” or “Simple Markup”. If you select “Simple Markup”, you will need to select **Show Comments** in the **Comments** group (see figure below).
Generating annual cost projection data for bridge assets from budget template

The BridgeAM-Budget_v2019.xlsx workbook is a comprehensive budgeting tool that allows you to plan your bridge maintenance budget allocations by organizing various types of bridge maintenance projects and their associated costs. It also helps to identify gaps in funding. Refer to the Instruction Guide for using the Bridge Asset Management Plan Template’s section Generating annual cost projection/gap analysis data from the budget template for complete instructions on using the BridgeAM-Budget_v2019.xlsx workbook.

To create a cost projection/gap analysis table for your compliance plan, follow the first two steps in the subsection Creating a Cost Projection/Gap Analysis Table; then, continue with the following steps:


4. In Word, navigate to section 2. Bridge Assets and subsection Programmed/Funded Projects, Gap Analysis, and Planned Projects, and locate Table 3: Planned Projects and Gap Analysis.

5. Select the [Delete table below, and paste new cost-projection/gap table here] placeholder and the empty table below the placeholder (see figure below).

![Table 3: Planned Projects and Gap Analysis](image)

6. Paste your cost projection/gap analysis table into the Word template (see figure below):
   In the Home ribbon, select Paste from the Clipboard group.

   OR: Right-click on your selection and select Paste from the dropdown menu.

   OR: Use the Ctrl + V keyboard shortcut.

7. Format the table as desired.

8. Return to Excel, save the file, and close the program.
Reviewing the template for errors and finalizing

The template can be checked for unfilled text fields that should have been replaced with required information. This check should be done to ensure that no text field is overlooked and forgotten. To check the template:

1. In the Mailings tab, select Check for Errors in the Preview Results group.

Word will open the Checking and Reporting Errors dialog box.

2. Select Complete the merge, pausing to report each error as it occurs, and select OK.

Word will prompt you to complete any unfilled text fields using a Microsoft Word information prompt window, such as the one below.

3. Enter in the requested information in the Microsoft Word information prompt window, and select OK.

4. Repeat step 3 until there are no more Microsoft Word information prompt windows remaining.

Microsoft Word will generate a new file, named Letters 01.docx, of your final asset management plan.
5. Save Letters 01.docx with a unique name—such as BridgeAMP_agencyabbr_2019.docx—in the desired location on your computer (see recommended save location information on page 1).
Updating the Table of Contents

Finally, make sure to update the Contents field to match the completed document.

1. Go to the Contents section on the second page of the document.

2. Select the Contents field.
   ⇒ The Contents listing will appear boxed with buttons located in the upper left corner of the field.

3. Select the Update Table button.

4. Select Update page numbers only from the Update Table of Contents dialog box that opens.

   ![Update Table of Contents dialog box]

**NOTE**: These procedures for the MS Word template file will generate one Word document. An export-to-PDF process similar to the Excel export detailed in the Entering data into the Excel template: Appendix section can be used to save the Word file as a PDF. This PDF can be merged with the three PDF appendix files using the full version of Adobe Acrobat or a free, open-source app that has a PDF-merge capability.
Inserting Appendixes
To create a single compliance plan document, save the compliance plan Word template, the pavement asset management plan Word document, the bridge asset management plan Word document, and any other associated files as PDFs. Then, using a PDF editing software program, merge the PDFs into a single PDF.

To save a Word document as a PDF:

1. Select **File** in the ribbon menu.

![File ribbon menu](image)

2. Select **Save as Adobe PDF** in the **File** sidebar menu (see figure below).

![Save as Adobe PDF](image)

OR: Select **Print** in the **File** sidebar menu (see figure above).

⇒ The Windows *Print* window will open (see figure below).
a. Select **Microsoft Print to PDF** from the *Print* window (see figure above).

b. Select **Print** (see figure above).

⇒ The *Save Print Output As* window will open.

c. Navigate in the *Save Print Output As* window to the desired folder containing compliance plan materials, enter a descriptive file name in the *File name* input box (e.g., *complianceplan_2019* or *complianceplan-appendix1_2019*), and select **Save**.

OR: In the *Home* ribbon, select **Create and Share Adobe PDF** in the *Adobe Acrobat* group (see figure below).

3. Once all necessary files have been saved as a PDF, proceed with using a PDF editor to compile all necessary PDFs into a single PDF.